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Introduction 
This document is based on Vantage Point’s internal Digital Accessibility Guide and is adapted for 

organizations to consider their unique branding. It will cover software which is commonly used 

across organizations but are not necessarily universal. However, much of the information is 

transferrable. 

It is also important to note there are many external links provided as resources throughout this 

document. They may change or discontinue without Vantage Point’s knowledge.  
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Why Design for Accessibility? 
Accessibility is a key factor in inclusive design and services. An organization’s level of 

accessibility for staff and clients, therefore, directly reflects its brand. 

Branding is like the iceberg analogy: what you see accounts for only 30% of the brand. For 

example, when most people think of your organization, they will probably recall its name, its 

primary colours, and/or its logo. However, those elements just scratch the surface. Brand also 

encompasses what those elements evoke for people when they think of your organization: 

Emotions and feelings associated with your services, your guiding principles and how they 

emerge in your work, and the level of care put into inclusive practices. 

Implementing a digital accessibility strategy ensures that everyone can access your digital 

resources, from newsletters to website, including individuals with disabilities. At any given time, 

over 20% of the population is living with a disability. In fact, most people will experience at 

least one disability in their lifetime. Disabilities may be temporary or permanent, and can relate 

to one’s vision, hearing, physical abilities, and cognitive abilities. Cognitive disabilities, which 

include (but are not limited to) problems with memory, attention span, or information 

processing, are the most common type of disability. For example, four times as many people 

experience cognitive disabilities than blindness.  

Universal design is the design and composition of an environment, product, or service so that it 

can be accessed, used, and understood to the greatest extent possible by everyone wishing to 

use it – and it is what we are essentially talking about when we discuss digital accessibility. 

Universal design benefits all users – not just those with disabilities. For example, closed 

captioning for video benefits individuals in loud or quiet environments in addition to individuals 

with hearing loss. 

While this document focuses on ensuring that your digital resources are accessible to everyone, 

universal design also applies to physical environments (for example, automatic doors make it 

easier for anyone to enter or exit a building) and learning environments. Universal design 

within a learning environment might include: 

• Allowing time for quiet reflection before jumping in and asking for participation 

• Giving the option to sit quietly and absorb instead of forced participation 

• Giving clear, written instructions for activities so people don’t have to rely on memory 

https://www150.statcan.gc.ca/n1/pub/89-654-x/89-654-x2018002-eng.htm
https://webaim.org/articles/cognitive/conceptualize/
http://universaldesign.ie/What-is-Universal-Design/
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Design Guidelines 
There are a few key principles to ensure documents are accessible for all. All users benefit from 

well organized and easy to understand content. This might include: 

• Ensuring a logical flow of ideas 

• Using headings and whitespace to separate ideas 

• Highlighting key concepts through headings, lists, or bold font 

• Choosing formatting that naturally guides the eye 

• Using plain language 

• Using a table of contents or website map where appropriate 

Another key component is ensuring that your content is presented or accessible in multiple 

ways/formats. For example: 

• Information can be consumed in a screen-reader friendly format (not as a png or jpg) 

• Alternative text (“alt text”) is available for non-text content 

• Captions and/or subtitles are available for all video, and transcripts are available for 

audio files 

For more information on Universal Design, read this article on the Seven Principles of Universal 

Design and this article on Accessibility, Usability, and Inclusion. 

Visual Design 

Headings 

Headings stand out from the rest of the text through use of larger font sizes, colour, emphasis 

(e.g., bold font), and surrounding whitespace. 

Most applications have built-in heading styles. Using heading styles benefits all users, as it 

allows screen readers to read the content more accurately and clearly, and, depending on the 

application, can make it possible to add hyperlinks within the document or automatically 

generate a table of contents. Headings also help guide the reader’s eye and divide the content 

into more comprehensive “chunks.” 

  

http://universaldesign.ie/What-is-Universal-Design/The-7-Principles/
http://universaldesign.ie/What-is-Universal-Design/The-7-Principles/
https://www.w3.org/WAI/fundamentals/accessibility-usability-inclusion/
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Colour Selection 

How colours, patterns, and images are used in a document can have a significant impact on 

how accessible the material is to individuals who are partially sighted or colour blind. When 

considering colour selection, there are several things to keep in mind: 

First, using high contrast colours makes it easier for partially sighted individuals to distinguish 

the content. Black on white or white on black offers the highest contrast, however, this can be 

too extreme for some users. Therefore, other dark colours (navy, dark green, or maroon) or 

pastels (ivory, light yellow) can be substituted.  

Note: Some organizations’ brand colours are not conducive to accessibility standards. And 

because re-branding may be an unrealistic goal in the moment, there may be other ways to 

situate the use of your brand’s colours so they appear more visible in various contexts. 

High Contrast Colour Schemes Low Contrast Colour Schemes 

• Black text on a white (or light) 

background 

• Black text on a yellow background 

• Yellow text on a black or dark blue 

background 

• Bright green text on a black 

background 

• Grey text on a white background 

• Grey text on a black background 

• Blue text on a green background 

Contrast ratios can be calculated using an online colour contrast calculator, such as TPGi Color 

Contrast Analyser or WebAIM’s Contrast Checker. For normal size font, the contrast ratio 

should be at least 4.5:1. For large, bold text or graphical objects this could be reduced to 3:1. 

Another consideration with choosing colour contrast is that individuals who are partially 

sighted or colour blind may have difficulty differentiating between certain colours. Two 

colours of a similar intensity may be indistinguishable from each other, even if they are on 

opposite sides of a colour wheel. For example, red and green may look the same to someone 

who has red-green or complete colour blindness.  

For this reason, it is important to avoid using colour as the only means of communicating 

information. Instead, consider combining colours and shapes or patterns to convey the 

information. For example, in addition to colour coding items green, yellow, and red, also 

include text and icons to convey meaning: 

https://www.tpgi.com/color-contrast-checker/
https://www.tpgi.com/color-contrast-checker/
https://webaim.org/resources/contrastchecker/
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• Success  

• Warning  

• Fail  

While pattern is an effective means of conveying information, text should be placed against a 

solid background whenever possible, as partially sighted individuals may have challenges 

distinguishing text from a patterned background. 

Learn more with WebAIM’s “Contrast and Color Accessibility” resource. 

Font selection 

Font selection can have a significant impact on the readability of your document. Here are a 

few things to keep in mind: 

• Choose a font size of at least 11pt for written (i.e., Word) documents. Larger font sizes 

are easier to read for partially sighted individuals, along with everyone who spends 

significant time staring at a computer screen. Since each font is sized slightly differently, 

the exact size you select can vary. 

• Current research suggests that sans serif fonts (fonts without extending features on 

each character) are generally easier to read, especially for digital applications. Note, 

however, that the research is not conclusive and that there are many factors that 

contribute to the readability of a particular font. Serif fonts may still work well in small 

amounts, such as titles and headings. 

• Best practice is to use bold font for emphasis, as both italics and underlines can make 

reading more difficult by causing the letters to merge together. 

• If using colour for emphasis, choose high contrast colours. i.e., a dark font on a light 

background. 

A final note to keep in mind with your font selection is how the font will appear on different 

devices. If you will be saving your document as a PDF before sharing it, you can choose any 

font. However, if you will be sharing your content as a Word document, choose a commonly 

used font the reader is likely to have on their device. 

Paragraph and line spacing 

Adding additional white space to your document by increasing the line spacing and paragraph 

spacing generally enhances the readability of your document when applied within reason.  

https://webaim.org/articles/contrast/
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For body paragraphs, using a line spacing of 1.15 to 1.25 is recommended. This helps readers 

move smoothly from one line to the next. Similarly, space bullet points somewhat further from 

each other than individual lines. This can be done in Word, for example, by selecting “Line 

Spacing Options,” and in the dialogue box, ensuring the “Don’t add space between paragraphs 

of the same style” check box is unchecked. 

Adding extra space between paragraphs and around headings creates a visual break between 

ideas. In general, you will want to add additional space before headings and after body text 

using the spacing tool, not by inserting line breaks. 

Compatibility with Screen Readers 

There are several screen readers available (NVDA is one of the most popular and is available for 

free online). Windows Narrator is built into the Windows operating system on PCs, and 

VoiceOver is available on Macs.  

• Full instructions for using Narrator can be found on the Windows Support website. 

• Full instructions for using VoiceOver can be found at apple.com. 

To get you started, here are a few keyboard shortcuts for using Narrator: 

• Turn Narrator on or off: press Windows + Ctrl + Enter.  

• Turn scan mode on or off: press CapsLock + Spacebar. Further scan mode commands 

can be found here. 

• In general, the up and down arrows will allow you to navigate through a document, with 

each segment of text (or alt text) being read out sequentially.  

• The right and left arrows will typically move one letter at a time. 

Similar shortcuts on Macs are as follows: 

• Turn VoiceOver on or off: press Command + F5 

• Interact with (read) page content: press down arrow 

• Stop interacting with page content: press up arrow 

There is a learning curve for navigating through a document using a screen reader such as 

Narrator or VoiceOver, however it is worth spending a bit of time playing with it to understand 

how different formatting affects the accessibility. The effects may depend on the settings 

https://www.nvaccess.org/
https://support.microsoft.com/en-us/windows/complete-guide-to-narrator-e4397a0d-ef4f-b386-d8ae-c172f109bdb1
https://www.apple.com/voiceover/info/guide/_1124.html
https://support.microsoft.com/en-us/windows/chapter-3-using-scan-mode-7b2af804-5a2f-90fd-b0e0-672f7cbbf2da
https://support.microsoft.com/en-us/windows/chapter-3-using-scan-mode-7b2af804-5a2f-90fd-b0e0-672f7cbbf2da
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selected within the screen reader. For example, Narrator can be set to read out five different 

levels of detail.  

Depending on the level of detail selected, details such as line breaks used to add white space to 

a document may be read out as “break”. If multiple line breaks are used, the word “break” 

would be read out each time. Likewise, other formatting characters such as tabs may be read 

out each time they are used. To avoid this potential annoyance, it is best practice to use styles, 

line spacing, paragraph spacing and indentation to create the visual effects you are aiming for.  

For non-professional communications, it is worth remembering that the full name of an emoji is 

read out each time an emoji is used. When corresponding with an individual who uses a screen 

reader, it is best practice to avoid long strings of emojis. Imagine hearing “face with tears of 

joy” being read out 12 times and not having the option of skipping over it. 

Headings 

Almost all applications have built-in heading styles. To ensure that your headings are accessible 

to all users, it is important to use the built-in styles (vs. manually adjusting the size and colour 

of the font). Using the heading styles ensures that the document or website is coded 

appropriately so that screen readers can navigate the document by jumping from one section 

to another. To someone who uses a screen reader, a document that does not use the heading 

styles would be akin to a cassette tape: the user would have to listen to the entire document to 

find the information they are looking for. However, when styles are enabled, the user can jump 

from one section to another, just as you can when listening to a CD or a digital playlist. 

Alternative Text 

All images, regardless of platform or purpose, should include alternative (alt) text. This will 

ensure people who use screen readers know the information, context, and/or sentiment you 

are trying to convey. Missing this visual context can create frustration and result in a negative 

experience, and ultimately cause a lack of understanding of the content. There are many 

guidelines which indicate it is not necessary to add alt text for purely decorative images. While 

this may be true, it is recommended to give people with visual impairments the option to know 

what is presented regardless of the purpose of the image. 

Key principles to keep in mind when writing alt text: 

• Short and to the point. Alt text should convey the most important aspects of the image 

and should be kept to a maximum of one or two sentences. 

https://support.microsoft.com/en-us/windows/chapter-4-reading-text-8054c6cd-dccf-5070-e405-953f036e4a15
https://support.microsoft.com/en-us/windows/chapter-4-reading-text-8054c6cd-dccf-5070-e405-953f036e4a15
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• Avoid redundant information (i.e., “an image of”) 

• When describing a chart, alt text should say what the chart is, then follow with the 

beginning, progress, and conclusion of the presented information. (i.e., “The pie chart 

shows workshop attendance over the first quarter: 90 percent in January, 86 percent 

in February, 91 percent in March, and 95 percent in April.”) 

 

Learn more about best practices when using alternative text in this guide from Cooper Hewitt.  

Hyperlinks 

Hyperlinks are an extremely useful tool for marketing and communications, making information 

succinct and easily accessible. However, if implemented without specific accessibility 

techniques in mind, they can have the opposite effect than what is desired.  

• Hyperlink common words, not URLs. If a URL is hyperlinked, screen readers will spell 

them out by individual character and will be difficult to skip over. 

• Hyperlink portions of phrases, not single words. Portions of phrases such as “on our 

website” are easier to target with a mouse and indicated where the user will be 

directed as opposed to hyperlinking single words like “here” or “website”. 

• Ensure colour contrast compliancy. Most hyperlinks are automatically coded in a 

vibrant blue. If you would like to use an on-brand colour for hyperlinks, test each 

colour in a colour contrast checker to see if one will be more visible than others. 

• Pair distinct colours with other distinct visual qualities (i.e., bold). Never solely rely 

on colour to convey meaning or context. 

  

https://www.cooperhewitt.org/cooper-hewitt-guidelines-for-image-description/
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Captioning, Subtitles and Transcripts 

Captions and subtitles are often used interchangeably but there are some differences. 

“Caption” is the most common term on Turtle Island (North America). They were founded in 

1972 with the introduction of “open captions” – burned-in on the screen and unable to turn off. 

Eventually, “closed captions” were provided so people could have the option to use captions or 

not. 

Captions tend to provide more information than just the words being spoken (i.e., music, 

audible cues, etc.) and are only provided in the original spoken language of the media in 

question. Subtitles can be found in different languages, and typically only provide the words 

spoken without other audible cues. 

Key principles for adding captions: 

• Identify the person speaking when they start speaking (i.e., [Name]: [Dialogue]) 

• Confirm spelling or proper nouns 

• Transcribe verbatim, including slang or non-conventional terms (i.e., “Imma” vs. “I’m”). 

Colloquialisms and slang should be spelled how they sound (e.g., “y’all”, “lookin’”, etc.) 

• If something cannot be understood, use “[inaudible]” 

• Non-verbal audio cues and non-dialogue sounds should be placed in square brackets. 

(e.g., [Sam laughs], [bell rings], etc.) 

• Try not to surpass character count, and do not surpass one line of text 

• Text should be white on dark background 

• Font should be between 24 and 30 pt. 

Design Considerations for Different Disabilities 

While impossible to list all the disabilities accessible digital media addresses, below are a few 

examples along with which software or features enhances digital user experience: 

Disability Design Considerations 

Colour blindness • Never exclusively relying on colour to convey information 

or meaning 

• High contrast colour ratios (Colour Contrast Checker) 

• Avoidance of certain colour combinations 

• Alt Text 

https://www.tpgi.com/color-contrast-checker/


 13 

Disability Design Considerations 

Blindness or partially 

sighted 

• Screen Readers 

• High contrast colour ratios (Colour Contrast Checker) 

• “Dark Mode” 

• Alt Text 

Hearing loss • Captions / Subtitles 

• Add visual notifications 

Physical disability or loss of 

mobility 

• Enable keyboard navigation 

• Enable voice commands 

Cognitive disabilities • Screen Readers 

• Captions / Subtitles 

• “Dark Mode” 

• Organized content 

• Properly spaced content 

• Mixed media 

Microsoft Word 
Creating accessible documents in Microsoft Word is fairly straightforward, especially if the 

document is text-based.  

Key elements of an accessible Word document are: 

• Use the styles built into the template 

• Ensure that all graphics have descriptive alt text 

• Run the accessibility checker 

• If creating a PDF from the Word document, ensure that you use the “Save As” 

function 

Styles 

Using the styles tool to add headings to you document makes it easier for all users to navigate 

the document. Using pre-specified styles to create your headings is of particular importance for 

users who rely on screen readers, as headings make it possible to jump from one section to the 

next to find the right information. Using the heading styles embedded also allows you to 

automatically generate a table of contents and add hyperlinks within your document. 

https://www.tpgi.com/color-contrast-checker/
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Styles can be found on the Home menu at the top of your window. 

 

Figure 1: Location of Styles on the Home menu 

Note: To create styles for your own documents and document templates, The Microsoft 

support website has instructions for customizing and creating new styles.  

Adding Lists 

Numbered, bulleted, and multi-level lists are a common and effective method of organizing 

content and highlighting key points. The controls for creating lists can be accessed on the Home 

menu. 

 

Figure 2: Buttons for creating and modifying lists 

Clicking on the small down arrow beside each list type opens a menu of options for customizing 

your list. Microsoft Support has additional information about defining new bullets, numbers, 

and multilevel lists. 

Remember to add spaces between each bullet item by de-selecting the “Don’t add space 

between paragraphs of the same style” check box in the “Line Spacing Options” dialogue box, 

which is explained in more detail below. 

Inserting a Table of Contents 

Including a table of contents can be helpful so readers can jump directly to the section of 

interest. When using styles to create your headings, Word can create an automatically 

generated table of contents. When adding a table of contents, you will also want to include 

page numbers in your document. 

https://support.microsoft.com/en-us/office/customize-or-create-new-styles-d38d6e47-f6fc-48eb-a607-1eb120dec563
https://support.microsoft.com/en-us/office/define-new-bullets-numbers-and-multilevel-lists-6c06ef65-27ad-4893-80c9-0b944cb81f5f
https://support.microsoft.com/en-us/office/define-new-bullets-numbers-and-multilevel-lists-6c06ef65-27ad-4893-80c9-0b944cb81f5f
https://support.microsoft.com/en-us/office/insert-a-table-of-contents-882e8564-0edb-435e-84b5-1d8552ccf0c0
https://support.microsoft.com/en-us/office/insert-page-numbers-9f366518-0500-4b45-903d-987d3827c007
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Inserting Page Breaks 

It is best practice to ensure that ideas are presented on the same page. As you near the final 

stages of editing your document, you may wish to use page breaks to ensure that ideas flow 

logically from one page to the next, and to avoid small chunks of isolated text. 

Adjusting Paragraph and Line Spacing 

To adjust the line spacing or paragraph spacing: 

• Right click on the Normal style in the styles pane 

• Select Modify from the pop-up list. A dialogue box will appear 

• Click on the Format button in the bottom left corner and select Paragraph from the 

pop-up menu 

• Another dialogue box will open which will allow you to adjust the line and paragraph 

spacing 

 

Figure 3: Adjusting line and paragraph spacing. 
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Images 

When adding images to a Word document there are two things to keep in mind: 

1. “In-line” images are more accessible to a screen reader.  

2. Include “Alt Text”, so screen readers can describe the image to the user. 

Word defaults to “in-line” when you insert an image into the document. For most purposes, in-

line images will be suitable. However, some documents may require more elaborate formatting 

where a different type of text wrapping is used. In this situation, it will be necessary to enhance 

the document’s accessibility using Adobe Acrobat Pro. 

To add Alt text, right click on the image and select “Edit Alt Text” from the pop-up menu. A 

sidebar will open. Edit or insert the Alt Text for your image. 

Formatting Tables 

Tables can be particularly challenging for screen readers to navigate. Two basic considerations 

for creating accessible tables are: 

1. Avoid merging cells as this disrupts how the screen reader navigates the table 

2. Format the top row as a header row 

• Highlight the top row, then right click on it 

• Select Table Properties from the pop-up menu 

• Click on the Row tab 

• Select “Repeat as headers row at top of each page” (even if your table will not 

break across pages). 

More detailed instructions for creating an accessible table can be found on the Perkins School 

for the Blind eLearning website. Note that complex tables may require an adjustment in 

Adobe Acrobat Pro to ensure accessibility standards are met. 

A Note About Editing Marks 

Screen readers will read out editing marks such as tabs and line breaks each time they are used. 

Best practice is to adjust the line spacing, paragraph spacing, and indentation using the styles 

whenever possible. 

Running an Accessibility Check 

https://www.perkinselearning.org/technology/digital-transitions/creating-accessible-table-word
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Microsoft Word, like other products in the Office suite, has a built-in accessibility checker. To 

run an accessibility check: 

• Click the Review tab in the ribbon 

• Click Check Accessibility  

A side bar will open in the editor with suggestions for improving the accessibility of your 

document. 

Exporting to PDF 

When saving your document as a PDF, it’s important to ensure the correct settings are enabled 

so to preserve the accessibility features which have been added to the document. The first 

thing to keep in mind is to create the PDF using the Save As feature.  

To check your settings, click on More options to open a dialogue box, then click on the options 

button. A new dialogue box will appear. Ensure that “Document structure tags for accessibility” 

is selected. 

 

Figure 4: Document structure tags for accessibility when exporting as a PDF 
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For longer documents, you may also wish to select the “Create bookmarks using headings” 

setting to add bookmarks to your PDF. Bookmarks will allow all users to easily navigate the 

completed PDF. 

Learn more 

• Make your Word documents accessible to people with disabilities, Microsoft Support  

• Microsoft Word: Creating Accessible Documents, WebAIM 

• Accessible Word Document Checklist, Queen’s University 

PowerPoint 
Ensuring accessibility of PowerPoint slide decks is similar to ensuring accessibility in Word. 

However, due to the complex nature of the program there are a few additional considerations. 

The following sections will highlight the differences only, so please be sure to read the Word 

instructions as well when considering PowerPoint accessibility. 

Content Placeholders 

To ensure content in a PowerPoint presentation is accessible to screen readers, use the content 

placeholders included in the slide layouts. Screen readers will pick up this content much more 

readily than content that is added to the slide in other ways. The size and location of the 

content placeholders can be adjusted on the slide to provide the desired look. 

To select a slide layout, click on the Slide button on the Home menu and select the desired slide 

layout from the pop up menu. If necessary, new slide layouts can be created in the Slide 

Master.  

 

Figure 5: Selecting a slide layout 

Once you have created your slides, you can verify that your text-based content is included in 

the content placeholders by opening the outline view by going to the View menu and selecting 

https://support.microsoft.com/en-us/topic/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
https://webaim.org/techniques/word/
•%09https:/www.queensu.ca/accessibility/how-info/accessible-documents/accessible-word-document-checklist
https://support.microsoft.com/en-us/office/what-is-a-slide-master-b9abb2a0-7aef-4257-a14e-4329c904da54
https://support.microsoft.com/en-us/office/what-is-a-slide-master-b9abb2a0-7aef-4257-a14e-4329c904da54
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outline view. In this view, as shown below, the slide previews on the left will be replaced with 

the text-based content from your slide. 

 

Figure 6: Outline view 

Finally, you will want to ensure the reading order is correct. The reading order check can be 

accessed by going to the Review menu, selecting Accessibility Check, and then selecting 

Reading Order Pane. The Reading Order Pane will open on the right side of your screen as 

shown in the next figure. 



 20 

 

Figure 7: Reading Order Pane 

Alternative Text 

Adding alt text to an image in PowerPoint follows the same process as adding alt text to an 

image in Word. The difference is that you can group objects together prior to adding alt text, 

then add alt text to the entire group instead of the component parts. 

To group objects together, first select all the objects you wish to group together, then right click 

and select “group” from the pop-up menu. Once the objects are grouped, add alt text the same 

way as you would in Word. 

Exporting to PDF 

As with Word, the presentation must be exported to PDF to ensure that the resulting PDF 

retains the accessibility features already added to the document. The process for doing so is 

slightly different than in Word. 

To export as a PDF, go to the File menu and select Export from the menu on the left. In the 

menu that appears, select Create PDF/XPS Document. 
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Figure 8: Exporting to PDF 

After clicking the button, a dialogue box will pop up. Select Options. Another dialogue box, 

shown below, will open. Ensure the “Document structure tags for accessibility” box is selected. 

 

Figure 9: PowerPoint save to PDF settings 
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Excel 
Excel is nearly fully optimized for screen-readers and only requires some considerations: 

• Alt text is required for all images and charts and is inserted in the same way that alt text 

is added in Word. 

• Hyperlinks are added by right clicking on the desired cell and selecting “Link…” or 

“Hyperlink…” (for Mac users).  

• Specified headings. Screen readers use specified headings to navigate through tables. 

To add headings: 

o Select the cells you want to include in the table 

o On the Insert tab, select Table 

o Select the My table has headers check box 

o Select OK (Excel creates a header row with the default names Column1, 

Column2, etc.) 

o Type new, descriptive names for each column in the table. 

o Once the pre-set has been made, you can use the Header Row check box under 

the Table tab for any following headers.  

• Unique names for sheet tabs. Adding descriptive names to each sheet helps individuals 

using a screen reader navigate through the spreadsheet. To add unique sheet names, 

right click on the sheet tab and select Rename. 

• No blank sheets. To delete blank sheets, right click on the sheet tab and select Delete. 

Additional instructions (with images) can be found on Microsoft Support. 

Portable Document Format (PDF) 
PDFs were originally created to be images set up for print. Accessibility came into the equation 

later as an after-thought, and so the function of accessibility is not always intuitive. 

Step one is to ask: Is this information meant to be read digitally? If so, could it be set up as a 

web page? (Note that HTML will always be more accessible than a PDF). 

https://support.microsoft.com/en-us/office/make-your-excel-documents-accessible-to-people-with-disabilities-6cc05fc5-1314-48b5-8eb3-683e49b3e593#picktab=macos
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If a PDF is required, it is essential to ensure the original source document (i.e., Microsoft Word, 

PowerPoint, etc.) is optimized for accessibility before it is exported as a PDF, as the accessibility 

of the source will determine the accessibility of the PDF. As a reminder, exporting is different 

than printing to PDF. Do NOT print to PDF, as this merely creates a non-accessible image file. 

In Adobe Acrobat Pro (after following steps for Microsoft Suite export) 

There are two tools you will want to keep in your Acrobat tool bar menu: 

1. Action Wizard 

2. Accessibility 

Using Action Wizard, select “Make Accessible” and fulfill all the menu items within the Action 

Wizard tool. 

1. Add Document Description (the following are recommended as priorities, but your 

organization can determine how much of the metadata it wants to fulfill) 

a. Title 

b. Subject 

c. Author 

2. Recognize Text Using OCR 

a. Document Language: English (UK) or English (US) 

b. Output: Editable Text and Images 

c. Downsample To: 600 dpi 

3. If the PDF is a form – Detect Form Fields 

4. Set Reading Language 

a. en-CA 

5. Set Alternate Text 

a. Ensure all images, tables, and graphs have alt text 

6. Run Accessibility Full Check 

Common Accessibility Check Required Fixes 

Title 

Right click on the action Title – Failed and select Fix. A dialogue box will appear, in which you 

may specify the title of the document, the author (this may be an individual on the staff, board, 

or volunteer for record keeping, or specified as the organization name as appropriate). 
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Logical Reading Order 

Navigate to the right-hand side of the accessibility menu. At the bottom will be a Reading Order 

item. Select this item and the reading order tool will appear. To learn more about specifying 

reading order, follow Adobe’s online guide. 

Colour Contrast 

Follow the guides provided above on colour contrast and perform a manual check using a free 

colour contrast checker (like this one from WebAIM). 

Alternate Text 

There are multiple ways to set alternate text. First, right click on the Accessibility Checker menu 

item Alternate Text and select Fix if the option is available. 

If there is no fix action, navigate to the Accessibility menu on the right-hand side and select Set 

Alternate Text. If this action does not recognize the images requiring alternative text, you will 

then want to label them correctly in the Reading Order tool, at the bottom of the Accessibility 

menu, by following these steps: 

1. If a box exists around the image, right click, and delete it. 

2. Once no box exists, drag the cursor around the image and ensure the selection 

incorporates the full image. 

3. Then, make sure the box around the image is highlighted (by clicking on the number in 

the top left corner if it is not already highlighted) and in the reading order tool panel, 

select Figure. 

4. Then, you may close the reading order tool if it is no longer needed, and set alt text 

through either one of the previous methods, or by right clicking on the image itself and 

selecting Alt Text… 

For more in-depth learning on Adobe PDF accessibility, there are tutorials on YouTube and 

webpage guides by Adobe.  

https://helpx.adobe.com/acrobat/using/touch-reading-order-tool-pdfs.html?mv=product&mv2=acrobat
https://webaim.org/resources/contrastchecker/
https://www.youtube.com/watch?v=ndNuOHeA4CI
https://www.adobe.com/accessibility/products/acrobat.html
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Zoom 
Zoom now offers auto-transcription to support users who benefit from having captions. The 

feature must be activated in the backend of Zoom (in your account settings). Once activated, it 

also requires the meeting host to manually "Enable Auto-Transcription" during each meeting. 

You can do this by: 

• Clicking the CC button along the bottom menu of Zoom (where you find Reactions and 

Share Screen options), then 

• Selecting Enable Auto-Transcription 

Meeting participants can turn off the subtitles in their view by clicking the CC button and 

selecting Hide Subtitles. 

Google Suite 
Google has embedded accessibility features within its products. The considerations for 

creating accessible documents within the Google suite is very similar to within other programs. 

Below are links to Google’s user guides for different programs: 

• Make your document or presentation more accessible 

• Present slides with captions 

• Accessibility for Docs editors 

MailChimp 
Accessible design for email marketing follows the same design guidelines noted above. The 

following sections provide specifics on how to apply formatting in MailChimp. Additional 

information can be found in Mailchimp’s Accessibility in Email Marketing. 

Headings 

As with other documents, the appropriate use of headings makes it easier for screen readers to 

navigate the document. MailChimp, like Word, uses Styles to assign the appropriate code to the 

https://support.zoom.us/hc/en-us/articles/207279736-Closed-captioning-and-live-transcription#h_45f95867-9c71-4acd-888f-5a1475b4cd8e
https://support.google.com/a/answer/1631886?hl=en
https://support.google.com/docs/answer/6199477?hl=en
https://support.google.com/docs/answer/9109474
https://support.google.com/docs/answer/6282736?co=GENIE.Platform%3DDesktop&hl=en
file://///EgnyteDrive/thevantagepoint/Shared/EDI/Accessibility/2021%20Accessibility%20Guide/Accessibility%20in%20Email%20Marketing:%20https:/eepurl.com/dyikrD
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text so that screen readers can navigate it. Under the “Style” tab, select “Page.” From there, 

you can pre-set all header styles with your organization’s branding. 

 

Figure 10: Mailchimp Styles Pane 

Note: The Header section under Style refers to the header at the top of the email, not text 

headers. 

Font Size and Selection 

Vantage Point has found 14pt to work best for body text in Mailchimp. Headings are kept 

between 24 – 30. This way, headings are differentiated from the body while no text is too big or 

too small. 

Use a sans serif font in body text for easy legibility. 

Subject Heading 

The subject heading is one of the first things people notice when an email reaches their inbox. 

It’s important to maintain both a marketing and accessibility lens when creating this content. 

Luckily, these overlap in some ways. Key principles for creating a good subject line: 

1. Clear and concise (Tell readers what to expect in the email) 

2. No symbols / emojis 

3. Personalized is always better (i.e., *|FNAME|* in Mailchimp) 
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Social Media (Hootsuite & Main 
Accounts) 
All social media platforms have the option to add alt text to images. Should an image be added 

to a post, describe the image as effectively as possible within the character count boundaries. 

A good idea, if the time and means are available, is to create a document to keep track of alt 

text used with images you frequently share on social media. It will save time in future social 

media planning. 
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Transforming Not-For-Profit 
Leadership 
We convene, connect, and equip not-for-profit leaders through 

interactive learning that is immediately applicable and 

professional development that lifts organizational capacity. 

1183 Melville St. 

Vancouver BC V6E 2X5 

 

T: 604.857.9144 

F: 604.875.0710 

 

e: info@thevantagepoint.ca 

www.thevantagepoint.ca 

mailto:info@thevantagepoint.ca
file://///EgnyteDrive/thevantagepoint/Shared/MKTG%20&%20COMMS/Branding/Templates/2021%20Template%20Updates/www.thevantagepoint.ca
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